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Entering your trial key allows you to save your projects 
and print them during your evaluation period. Entering 
your license key allows you do the same, except with-
out any time limitations. 

1. Start by opening up an image in Photoshop. 
2. Go to Filters -> Topaz Labs -> Detail 2 -> Menu -> Enter 
key. 
3. You can then copy and paste or type your key in.

Important: To install the product on a second com-
puter, you will need to download Topaz Detail and then 
enter your same license key.

Host-Specific Installation
Topaz Detail is also compatible with Lightroom, Aper-
ture and iPhoto.  To use Detail in any of these programs 
you will need to download and install the free Topaz 
Fusion Express compatibility add on.  You can get it 
online at: www.topazlabs.com/downloads

In Windows, Topaz Detail is supported by most host 
applications that support Photoshop plug-ins.  This 
includes Paint Shop Pro, Photo Impact, Painter, and 
Irfanview, although there are additional host programs 
that may also support Topaz Detail. 

To install Detail in either Paint Shop Pro, Photo Impact, 
or Irfanview first download Topaz Detail to the default 
location.  Then, to configure it into each program, fol-
low the host-specific instructions on the next page. 

Topaz Detail is a Photoshop plug-in, which means it 
won’t run by itself and requires a compatible host pro-
gram. 

To Install
1. Close Photoshop or other image editing program if 
you are using it. 

2. Open the Topaz Detail zip file, double-click on the 
Topaz Detail installer, and then follow the on-screen 
instructions. 

3. Your Topaz plug-ins will automatically be installed in 
your Photoshop plug-ins folder. 

4. After the installation, you will need to enter your 
license or trial key. 

Important for Mac Users: 
After installation, Topaz Detail will be installed in the 
following folder: “ HD -> Library -> Application Support 
-> Topaz Labs -> Detail 2”.

If your Photoshop is installed in a customized location, 
you will need to manually create a shortcut (alias) link 
inside folder “<Photoshop install folder> -> Plug-ins” 
that links to “ HD -> Library -> Application Support -> 
Topaz Labs -> Detail 2 -> Plug-ins”.

Installation

             Mac Dmg         Windows Zip             Mac Dmg              Mac Dmg 
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1. First launch PaintShop Pro / Photo Impact.

2. Go to Menu file -> Preferences -> File Locations. 
Select “Plug-ins” from the “File Types” list and click 
“Add”. 

Installation
3. Choose C:\Program Files\Topaz Labs\Topaz Detail 2 
plug-ins and click “OK”. 

4. Topaz Detail 2 is now available to use.  Simply go to 
Effects -> Plug-ins and select “Topaz Detail 2”.
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1. First launch  Photo Impact.

2. Go to File -> Preferences -> General or use shortcut 
key F6. 

3. Select Plug-ins from the Categories list. 

Installation
Then click on the           button and browse to find the 
Detail plug-in folder located in:  C:\Program Files\Topaz 
Labs\Topaz Detail 2 plug-ins and then click “OK”. 

4. Restart Photo Impact.  Go to Menu -> Effect to ac-
cess plug-in.
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1. Make sure that you have downloaded and installed 
the 8bf plug-in add-on, available on the Irfanview 
webpage. (http://www.software.com/irfanview-plugin)

2. Open Irfanview and go to Image -> Effects -> Adobe 
8BF filters. 

3. In the screen that pops up, select “Add 8BF filters” 
and navigate to the C:\Program Files\Topaz Labs\To-
paz Detail 2\Plug-ins folder and click “OK”.  You will 
then see “Topaz Detail 2” in the Available/Loadable 
8BF Filters section. 

4. To use Topaz Detail 2 in the future, simply go to 
Image -> Effects> Adobe 8BF filters again and select 
“Topaz Detail 2”.

Installation
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Uninstalling
3. Select Programs, then Uninstall a Program.

4. Select Topaz Detail and click remove. 

 
Windows 7*

1. Quit Photoshop (or other editing program).

2. Click on the Start Menu and select Control Panel -> 
Programs -> Programs and Features. 

3. Select Topaz Detail and click uninstall. 

*Please note that if you also have the 64-bit version 
of Detail installed, then you will need to first uninstall 
this version before you can uninstall the regular ver-
sion. 

To uninstall Topaz Detail follow these instructions:

Mac
1. Quit Photoshop (or other editing program).

2. Navigate to the Topaz Labs support files and frames 
located at: Macintosh HD -> Library -> Application Sup-
port -> Topaz Labs. 

3. Locate the Topaz Detail file and move it to the 
trash. You will need to enter your system password to 
OK this change. 

4. Navigate to your Photoshop plug-ins folder located 
at: Applications -> Photoshop -> Plug-ins

5. Locate any leftover Topaz Detail files and move it to 
the trash. 

Windows XP*

1. Quit Photoshop (or other editing program).

2. Click on the Start Menu and select Control Panel.

3. Double-click on Add / Remove programs.

4. Select Topaz Detail and click remove. 

Windows Vista*

1. Quit Photoshop (or other editing program).

2. Click on the Start Menu and select Control Panel.
Before Topaz Detail After Topaz Detail



8

User Manual
To

pa
z 

 D
et

ai
l Topaz Detail

About Topaz Detail
Topaz Detail is dedicated to micro and macro detail en-
hancement.  Which allows you to individually or collec-
tively adjust the small, medium and large details within 
your image for a fully customized look.  

You can easily achieve unique detail, tone, contrast and 
color effects that will make your photos pop without 
creating halos.  The other unique aspect about Topaz De-
tail is it’s ability to create strikingly crisp black and white 
images.  Detail includes a convenient black and white 
preset that you can use as a starting point.

The Primary Functions of Topaz Detail Include: 

1. Dynamically enhance large image details to give im-
ages depth and more oveall appeal. 

2. Intelligent small detail enhancement / reduction with 
innovative detail manipulation functions. 

3. Unique color effects via advanced color processing. 

4. Advanced tone adjustment features that allow for 
individual RGB, shadow, highlight, brightness and con-
trast balancing.

5. Reduce minor instances of blur in images for better  
overall detail and sharpening enhancements. 

6. Create stunning black and white images. 

Introduction

Before Topaz Detail

After Topaz Detail

Visit the Detail Gallery to see Topaz Detail at work:
http://gallery.topazlabs.com/keyword/detail

http://gallery.topazlabs.com/keyword/detail
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Introduction

probably because it has the most advanced break-
through technological algorithms.)

4. The user adjusts the large, medium, and small detail 
sizes, and each individual detail layer is affected ap-
propriately.  If you like, you can see what each of the 
four individual layers looks like.  To see the base layer 
by itself, turn the large, medium, and small sliders 
to0.  To see each individual detail size layer, drag that 
particular one all the way to the right and set the con-
trast to0 (which will switch the base layer to neutral 
gray).

5. The luminance layer is re-combined with the ad-
justed small, medium, and large detail layers as well as 
the base layer.

How Detail Works

1. Start with your original image. Invoke Topaz Detail.

2. Pre-processing starts. Topaz Detail separates your 
image into two.  One based on chrominance (color 
information) and one based on luminance (grayscale 
information).  These will undergo different processing 
methods and will be affected by different sliders.

3. The luminance information is further internally 
broken down into three detail layers based on size, 
and a base layer.  Manipulating these four layers make 
up the bulk of the detail enhancement functionality 
of the software.  After this step, pre-processing ends 
and the Topaz Detail user interface pops up.  (This is 
also the portion of pre-processing that runs the slow-
est... 

Walk through the internal steps that Topaz Detail takes from start to finish.
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Introduction

6. Highlight and shadow protection, as set by the 
user, is applied to the luma layer.

7. The internal luma and chroma layers are re-com-
bined to form your startlingly good final processed 
image.

Steps 5, 6, and 7 take no time at all. This means that, 
although there can be a sometimes annoying wait for 
the initial pre-processing stage, there will be no actual 
waiting after that.  All adjustments are made instanta-
neously after the necessary initial pre-processing.

This is the complete internal workflow that Detail 
uses. Now that you know, it becomes quite obvi-
ous how it can sharpen and enhance detail without 
creating any halos - simply because it doesn’t really 
“sharpen”!  All it does is increase the intensity of the 
appropriate detail layer, which gives a sharpening 
effect without any of the negative artifacts normally 
associated with sharpening or detail enhancement.

Before Topaz Detail

After Topaz Detail

To connect with other Topaz users, participate in Topaz 
contests and to see the latest tips, tricks and tutorials sign 

up for the new Topaz Forum online at:
 www.topazlabs.com/forum
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Topaz Detail 2.0 Features

1. Auto Updater.  Get software updates instantly.

2. New user interface.

3. Snap / Recall buttons.  Save up to 99 snapshot set-
tings for comparison. 

4. Undo / Redo buttons. 

5. Collapsible side panels.  Expand and collapse the 
preset panel and the tool panel for an adjustable 
workspace. 

6. Collapsible tabs.  Open and close the parameter 
tabs as you need them. 

7. Preset Enable / Disable option.  Option to enable 
or disable the preset preview processing at program 
startup. 

8. Presets Layout.  New preset format with single 
preset preview window. 

9. Preset Navigation.  Use the up / down arrow keys 
to navigate the preset list and display the selected 
preset thumbnail (in preset preview window). Use 
the return (Enter) key to apply the currently selected 
preset.

10. Enable / Disable Tool Tips.  Option to enable or dis-
able the pop up tool tips. 

11. Quick Slider Reset.  Double click on the slider name 
to reset default slider values.

12. Speed Improvement.  Speed increase for process-
ing large images.

Introduction

Before Topaz Detail

After Topaz Detail
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Work Area

Interface (Main View)
Although the Topaz Detail interface may look intimidating at first glance, don’t worry: it’s actually quite simple and easy 
to use.  You’ll soon be a pro after experimenting with it for a bit. In order to make sense of the function of each of the 
various controls, we have divided the interface into a few sections:

1 3
4

5

333311

1. Presets Preview 5. Settings & Parameters2. Presets Panel 4. Preview Navigator
The removable pre-
view window displays
preset previews. 

Controls the editing using sliders 
to adjust the various effects.

Provides “snapshots”
 of pre-defined effects.

Displays the region of the
preview image you are 
currently focused on. 

3. Preview Window
Displays the preview of the 
original and adjusted image. 

2

5555

44
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Work Area

Interface (Tool Panel View)
Use the small white arrows to expand and collapse the preset panel.  You can click the white arrow            or grab the 
edge of the panel and drag it in or out.

3

4

3333

44

ou can click the white arrow            or grab the 
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Work Area

Interface (No Panel View)
Use the small white arrows to expand and collapse the preset and tool panels.  You can click the white arrows                    
or grab the edge of the panels and drag them in or out.

ou can click the white arrows                    ou can click the white arrows                    ou can click the white arrows                    
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Work Area

Interface (Preset Panel View)
Use the small white arrows to expand and collapse the tool panel.  You can click the white arrow                or grab the 
edge of the panel and drag it in or out.

ou can click the white arrow                or grab the 
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mouse button on the preview image and drag it 
around.  When you let go of the mouse button, the 
new portion of the image will be processed and the 
result will be displayed. 

Preview Section 
The Preview section is the main element that is cen-
tered in the Detail interface. The preview section 
shows you the original image and the processed pre-
view of the image. 

Switch between the Original and Preview tabs to com-
pare the filtered and un-filtered images. 

Work Area

You can also use SPACE bar to switch back and forth 
between your filtered and unfiltered image in the preview 
window.

1
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The “Ctrl +” and “Ctrl –” keys zoom in and out of the 
image, just like in Photoshop.  

You can use the arrow keys to adjust the value of the 
slider that is currently selected.  

A complete list of the shortcut keys can be found in 
the Shortcut Keys section later in this manual.

You can zoom in or out of the preview image by click-
ing the “+”, or “-” buttons below the preview image.
You can also resize the window as well by dragging 
the bottom right corner in and out. 

The “Fit” button will fit the entire image into the pre-
view window. 

The “100%” button will zoom to 100% view. 

If zoomed below 100% the preview image will be inter-
nally resized in order to speed up preview updating.
 

Work Area

Photoshop and other host software support many Image 
Modes, such as Grayscale, RGB, LAB, CMYK, etc. Images 
can also be 8, 16, or 32 bits per channel. Topaz Detail 
supports both 8 bits per channel and 16 bits per channel. 
Topaz Detail supports RGB mode only. To work on black-
and-white images, first convert them to RGB mode.
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Work Area

Presets
Presets are a great way to speed up and simplify the 
whole process of using Topaz Detail. Presets are set 
previews with previously defined settings that you 
can recall and reapply at any time. 

We’ve included some default presets for you and, al-
though they won’t work for every single photograph, 
they serve as excellent starting points for customized 
tweaking.  

Applying Presets 
Applying a default preset is easy and intuitive. Simply 
clicking on a preset will change all the settings in To-
paz Detail to match those in the selected preset. 

To get the exact results you want, you may still want 
to go through the tabs and tweak the parameters.

Adding Presets
Sometimes it’s convenient to be able to define pre-
sets and save your settings for later use.  To do this, 
first adjust the Topaz Details parameters until you’re 
satisfied with the result. Then, click on “Save”. 

 
 

1. Presets Preview
The removable preview 
window displays
preset previews.  Click 
Hide / Show to expand or 
collapse the preset pre-
view window at anytime 
during your workflow.

2. Presets List
Lists all of the saved pre-
sets available for use. 

3. Preset Options

The preset options al-
low you to save your 
presets, delete presets 
(default presents cannot 
be deleted), import new 
presets and export your 
saved presets to share 
with your friends. 

Remember that you can easily expand or collapse the presets 
panel by clicking on the small white arrow on the edge of the 
panel or by grabbing the panel edge and dragging it in or out.

2

3

1
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Work Area
Then enter a preset name, select the type of image 
that it is good for and then enter a description and 
click “OK”.  You can also select a second image cat-
egory type that the preset is good for. 

Note that if the name you’ve entered is the same as a 
preset you’ve already defined then you will be asked if 
overwrite the previous one. 

Your preset will be automatically saved as a new file 
with a “.tpp” extension in the Topaz Detail Presets 
menu and the preview is automatically generated.  To 
apply it later, just click it like any other preset. 

Deleting Presets
If you’d like to delete a preset, use the Delete option 
with your desired preset selected. 

Please Note: Default presents cannot be overriden or 
deleted.  Once you delete a preset it or overwrite it, it 
cannot be retrieved. 

Saved presets are located in the Topaz Detail “Presets” folder:
C:\Program Files\Topaz Labs\Topaz Details\Presets unless 
you’ve opted to install Topaz Details into a different directory. 

Mac users have this folder at HD/Library/ApplicationSupport/
TopazLabs/Details/Presets. 
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Work Area

Exporting Presets
To export the preset file to a certain location, click 
“Export”. 

Name your preset and save it to your desktop or 
other specified location that you have reserved for 
saved presets.

You can then share this preset file with others who 
may then import it. 

Sharing Presets
Feel free to share your saved presets by emailing 
them to your friends and having them put it into their 
Topaz Detail Presets folder.  

Importing Presets
To import a preset file, click the “Import” button.

This will open up a “Browse” box to import a saved 
preset from your computer into Topaz Detail.  This is 
useful if you have downloaded a preset file that you’d 
like to use. 

Visit the Topaz Labs Blog which features the latest 
Photography, software and design information including 

tutorials, videos, and thoughts about both Topaz and 
non-Topaz topics.
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Work Area

Tools
You will use the various tools in the tools panel during 
your workflow to make your image adjustments.

1. Preview Navigator - Displays the region of the
preview image you are currently focused on.

2. Zoom Buttons - Use the zoom buttons to zoom in 
and out of your image.  Or you can also set your image 
to fit the preview window or to view it at 100%. 

3. Undo and Redo buttons

4. Snap and Recall buttons.  Save up to 99 snapshot 
settings for comparison. 

5. Sliders and Parameters - Controls the editing pro-
cess using sliders to adjust the various effects.

6.  Additional Slider Controls - Use the “Reset All” but-
ton to reset all of the sliders values back to zero.  Use 
the “I Feel Lucky!” button to apply randomized 
settings to your image.  This is useful when you 
want to experiment with different settings. 

Have more questions about Topaz Detail  2 or any of the 
other Topaz software programs?

 Check out the new Topaz Knowledge Base online at: 
www.topazlabs.com/support/kb

3

2

6

4

55555

1
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Checks for available Topaz Detail updates. 

Click the Show Details button to get find out what’s 
included in the update before you install. 

Menu
You can access Topaz Detail’s menu by clicking on the 
“Menu…” button at the bottom of the interface. 

Preferences
Select this to enable or disable the program tool tips 
or the Auto-Update feature. 

Work Area
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Work Area
Gallery
Select this to open up your Internet browser and go 
to the Topaz Detail image gallery to see other user im-
ages enhanced with Topaz Detail.

MyTopaz
Brings you to the Topaz community where you can 
connect and interact with other Topaz users.  Here 
you can also participate in discussions and contests, 
and share your favorite Topaz images. 

Tutorials
Brings you to the Topaz Detail tutorials page where 
you can access a variety of helpful video and text tu-
torials.  You can also submit tutorials that you created 
here as well.

About
Select this to see what version of Simplify you cur-
rently have.

Enter Key
Select this to enter your trial or purchased license key. 

What’s This?
Select this (or click F1) then click on a feature in the 
Detail interface to learn more about it. 

Users Guide
Select it to pull up this user guide.

Tech Support
Brings you to the Topaz Labs support page where 
you can request assistance from our support special-
ists, contact our customer service team, retrieve lost 
license keys, or browse through our Knowledge Base. 

Product Info
Select this to go to the Topaz Detail web page to learn 
more about the Topaz Detail plug-in.
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What is Pre-Processing?
Pre-processing is an automated process that divides 
your image up into three layers of image detail: Small, 
Medium and Large. 

Why is pre-processing necessary?
The unique method of pre-processing is necessary 
because it extracts image detail in a way that does not 
introduce a halo-effect when you go to manipulate 
your image with the adjustment sliders. 

Is it supposed to take this long?
Yes, pre-processing can take a few minutes, especially 
if you are using a larger image.  Delayed pre-process-
ing times allow for quicker post-processing times 
after you finish your image adjustments.  

Does my image have to be pre-processed?
Yes, all images must be pre-processed before being 
enhanced in Topaz Detail. 

Parameters
Topaz Detail has four settings tabs and a total of 18 
parameters to help you achieve optimal image results. 

Settings & Parameters 

Looking for quick, crisp black and white conversion like 
the cat image to the right?

Use the BW Contrasted preset in the Topaz Detail presets 
menu to instantly transform your image to black & white. 
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Settings & Parameters 

Details
The Details tab uses an innovative layering technique 
that allows you to adjust three levels of details within 
an image.  It can adjust the small, medium and large 
details in an image. Different combinations of the de-
tail settings an create many different possibilities.  

Small Details
Small details adjustment parameter. Adjusting this 
parameter affects the visibility of the very fine details 
in an image.

Small Boost
Adds more flexibility to the small-detail slider. The 
boost will weaken or strengthen the smaller details.

Medium Details
Medium details adjustment parameter. Adjusting this 
parameter affects the visibility of the medium details 
in an image.

Medium Boost
Adds more flexibility to the medium-detail slider. The 
boost will weaken or strengthen the medium details.

Large Details
Large details adjustment parameter. Adjusting this pa-
rameter affects the visibility of the very large details in 
an image.

Large Boost
Adds more flexibility to the large-detail slider. The 
boost will weaken or strengthen the large details.

A great way to fix skin texture and reduce image noise
 is to use the Small Details and Small Boost slider. 

Need to reset your slider values? 

Simply  double-click on the slider name above the slider 
control to instantly reset the slider value to 0. 
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Affects the brightness of the shades closely related to 
the red color range. 

Magenta-Green Tone
Affects the brightness of the shades closely related to 
the green color range. 

Yellow-Blue Tone
Affects the brightness of the shades closely related to 
the blue color range. 

Brightness
Controls the overall brightness of the image.  

Contrast
Controls the range of tones from light to dark in the 
image.

Shadow
Built-in protection from shadows (the darkest tones). 
Increasing this parameter reduces the harshness of 
shadows and reveals previously obscured detail in 
shadow areas.  A setting of 0 disables shadow protec-
tion.

Highlight
Built-in protection from highlight (the lightest tones) 
blowout.  Increasing this parameter reduces the 
harshness of highlights and reveals previously ob-
scured detail in highlight areas.  A setting of 0 disables 
highlight protection.

Tone
The Tone tab allows you to increase or reduce the 
quality of brightness, deepness, or hue of a tint or 
shade of a color in the image.  This tab gives the user 
creative control over enhancing or suppressing the 
range of color.
 

Settings & Parameters 

Please visit the Topaz Detail website at http://www.to-
pazlabs.com/detail for video tutorials, tips, and tricks!
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The Color tab applies adaptive color processing. It 
works on the image’s color. Interesting color effects 
can be created here. 

Saturation
Standard parameter to increase or decrease the over-
all saturation of the image.

Saturation Boost
Saturation boost increases the color detail of the 
weaker colors in the image. 

Hue 
A convenient hue correction control. 

Deblur
The deblur tab allows you to reduce blur in your im-
age so that your detail enhancements are clear, crisp 
and sharp for maximum effect. 
 

Strength
Standard parameter to increase or decrease the 
amount of blur reduction in the image. 

Radius
The larger the radius is, the larger the size of the de-
blurred details will be.  The smaller this parameter is, 
the smaller the size of the de-blurred details. 

Additional Deblur notes:
1. Not every image requires use of the deblur tab. 
2. Ideal use is for small occurrences of blurriness. 
3. Most useful when resizing high-pixel count images.
4. Over-applying will result in image graininess. 
5. Best when used in conjunction with the Small De-
tails and Small Boost sliders. 
6. Preview zoom MUST be 50% or more or the Deblur 
feature will not be accessible and you will see the 
message below:

Settings & Parameters

The best way to get great-looking images is to experiment with 
the filter until you’re satisfied. Despite the number of sliders 
and settings, getting a great result is easier than you might 
think!

Strength
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example.  You can see the difference in detail and 
color enhancement in the Before and After shots.  In 
the following steps, we will show you how to achieve 
optimal results with your own photos, following this 
model. Let’s get started.

1. Open an image file. 

2. Create a duplicate layer of your image.  Right-click 
on your image layer in your layers and select “Dupli-
cate Layer”.  You can also achieve this by selecting 
your image layer and dragging it down to the new 
layer icon. 

Sample Project #1
In this section, we will walk you through a sample 
project, step-by-step, to help you become more famil-
iar with the Detail program.

                                          Before Detail       

                                             After Detail

Workflow

  After Detail  After Detail
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5. Once your image loads,  use the zoom tools to 
zoom in on a specific part of your image.  Then you 
can click on the preview and drag it around until you 
find an area that you like. 

We want to enhance the natural details and elements 
of this image so we will be working with the adjust-
ment sliders for this example, but you can start any 
way you like.

3. To begin working on your image go to Filters -> 
Topaz Labs -> Detail 2

4. When you start Topaz Detail your image will go 
through a pre-processing phase to prepare you image 
for the detail adjustments.  This may take a minute. 

 

Work Flow

For more color, exposure and detail tools be sure to 
check out Topaz Detail at: www.topazlabs.com/detail
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If you are satisfied with the preset adjustments then 
you can click “OK” to process your image and save it 
back to Photoshop. 

If you would like to make some additional adjust-
ments to your Detail settings then you can do so by 
adjusting any of the sliders in the four tabs manually 
until you achieve your preferred image results. 

 6. If you want to choose a default preset, scroll 
through the panel on the left side of the screen.  To 
select it, just click on it and the sliders will automati-
cally adjust to the pre-defined settings and param-
eters.  For this example we will be using the Creative 
Detail Accent preset.

Don’t forget that you can use the shortcut keys in 
Topaz Detail 2 to speed up your workflow.

Work Flow
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individual tonal-range of colors in the image.  This is 
where you can really make your photo pop.

10. Gently adjust the Tone sliders to increase or reduce 
the amount of brightness in a particular color range. 
Then use the remaining sliders to adjust the quality 
of brightness, deepness, or hue of a tint or shade of a 
color in the image. 

7. Start in the Details tab.  It is a good idea to begin 
here, and then progress to the Tone, Deblur and Color 
tabs in order to see the effects of your adjustments 
easily. 

8. Slowly adjust the Small, Medium and Large detail 
sliders to enhance the detail effect in the image.  Then 
adjust the Small, Medium and Large Boost sliders 
which will allow you to adjust the intensity of the 
Small, Medium and Large image details.

When you are happy with the Detail settings, move to 
the Tone tab. 

Work Flow
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Workflow
Finally, in the Color tab, you adjust the saturation and 
hue in your image.  Use the sliders here to perfect the 
overall color in your image. 

All that’s left now is to click OK and watch your image 
transform. 

Now you should have a dramatically enhanced and 
colorful image!

When you are happy with the Detail settings, move to 
the Deblur tab.  Please note that note every image will 
need adjusting in the Deblur tab.  If your image does 
not require adjusting in this area then feel free to skip 
this part and move on to the Color tab for your final 
adjustments. 

11. The Deblur tab allows you to reduce small occur-
rences of blurriness in your image.

10. Gently adjust the Strength sliders to increase or 
reduce the amount of blur reduction in your image. 
Then adjust the Radius slider to determine how that 
blur reduction is applied. 

When you are happy with the Deblur settings, move 
to the Color tab. 

StrengthStrength

If you see a difference in color from the preview in the 
Topaz Detail interface and the final processed image

 back in Photoshop then you will want to turn off your 
Proof Color feature in Photoshop.  You can do this by 

going to:  View -> Proof Setup
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Workflow

We will be using this photo for our example.  You can 
see the difference in detail enhancement and color 
desaturation in the Before and After shots.  In the 
following steps, we will show you how to achieve 
optimal results with your own photos, following this 
model.  Let’s get started.

1. Open an image file. 

2. Create a duplicate layer of your image.  Right-click 
on your image layer in your layers and select “Dupli-
cate Layer”.  You can also achieve this by selecting 
your image layer and dragging it down to the new 
layer icon. 

Sample Project #2
In this project, we will walk you through a second De-
tail workflow, this time focusing on color to black and 
white conversion. 

    Before Detail       

 After Detail
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Workflow
5. Once your image loads,  use the zoom tools to 
zoom in on a specific part of your image. Then you can 
click on the preview and drag it around until you find 
an area that you like. 

We want to transform this image into a black and 
white image and also enhance the natural details and 
elements of this image so we will be working with the 
presets and detail sliders for this example, but you 
can start any way you like.

3. To begin working on your image go to Filters -> 
Topaz Labs -> Detail 2

4. When you start Topaz Detail your image will go 
through a pre-processing phase to prepare you image 
for the detail adjustments.  This may take a minute. 
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Workflow

If you are satisfied with the preset adjustments then 
you can click “OK” to process your image and save it 
back to Photoshop. 

If you would like to make some additional adjust-
ments to your Detail settings then you can do so by 
adjusting any of the sliders in the four tabs manually 
until you achieve your preferred image results. 

 6. If you want to choose a default preset, scroll 
through the panel on the left side of the screen. 
To select it, just click on it and the sliders will 
automatically adjust to the pre-defined settings 
and parameters.  For this example we will be 
using the BW Contrasted preset.

Don’t forget that you can use the shortcut keys in 
Topaz Detail 2 to speed up your workflow.
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Workflow
the Tone tab. 

9. The Tone tab gives you optimal control over the 
individual tonal-range of colors in the image.  The con-
trast slider will be the most important setting here.

10. Gently adjust the Tone sliders to increase or reduce 
the amount of brightness in a particular color range. 
Then use the remaining sliders to adjust the quality 
of brightness, deepness, or hue of a tint or shade of a 
color in the image. 

7. Start in the Details tab.  It is a good idea to begin 
here, and then progress to the Tone, Deblur and Color 
tabs in order to see the effects of your adjustments 
easily. 

8. Slowly adjust the Small, Medium and Large detail 
sliders to enhance the detail effect in the image.  Then 
adjust the Small, Medium and Large Boost sliders 
which will allow you to adjust the intensity of the 
Small, Medium and Large image details.

When you are happy with the Detail settings, move to 
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Workflow
Finally, in the Color tab, you adjust the saturation and 
hue in your image.  Use the sliders here to perfect the 
overall color in your image. 

All that’s left now is to click OK and watch your image 
transform. 

Now you should have a beautiful black & white image.

When you are happy with the Detail settings, move to 
the Deblur tab.  Please note that note every image will 
need adjusting in the Deblur tab.  If your image does 
not require adjusting in this area then feel free to skip 
this part and move on to the Color tab for your final 
adjustments. 

11. The Deblur tab allows you to reduce small occur-
rences of blurriness in your image.

10. Gently adjust the Strength sliders to increase or 
reduce the amount of blur reduction in your image. 
Then adjust the Radius slider to determine how that 
blur reduction is applied. 

When you are happy with the Deblur settings, move 
to the Color tab. 
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Glossary
that photo, which may be represented by three color 
channels, each of red, green or blue.

Color Profile - defines the range of colors that can ap-
pear in a digital photo.

Desaturate - Decreasing the intensity of a color (hue).

Download - The process of transmitting or transfer-
ring data from one device to another.

Export - Outbound data transfer in a format that can 
be used by other programs.

Grain - Lightly-speckled noise that is used to apply a 
more natural look to an image.

Hue - One of the main properties of a color, described 
with names such as “red”, “yellow”, etc.

Import - Inbound data transfer into a file or docu-
ment.

ISO - The amount of sensitivity of a digital camera sen- 
sor. A higher ISO enables faster shutter speeds and/or 
better performance in low light, but is more suscep-
tible to experiencing increased noise.

Noise - Visible effects of interference in an image from 
a digital camera.  Often appearing as random col-
ored dots sprinkled throughout the image or uneven 
coloration in what should be smoothly-colored areas. 
It is most likely to show up in the darker or shadowed 
areas of an image.  Noise can be an undesirable effect 

Achromatic - Without color.

Adjustment Layer – A layer that allows you to adjust the 
look of an original image with out making it permanent. 
With adjustment layers you can make various changes to 
a layer without damaging it and go back and readjust it at 
anytime.

Algorithm - Any bit of code or programming that de- 
fines a process.

Blur - Make or become unclear or less distinct.

Brightness - The degree to which a color sample ap-
pears to reflect light. 

Chroma - Purity or intensity of color. The difference 
of a color against the brightness of another color that 
appears white under similar viewing conditions.

CMYK - Cyan, magenta, yellow, and black. A color 
model commonly used for 4-color printing by printers 
to define and mix all of the colors they are capable of 
outputting.

Color - The human perceptual response to different 
wavelengths of light impinging on the photo recep-
tors in the retina.

Color channel - The visual component of a color digi-
tal image that represents all the pixels in that picture 
made up of a specific primary color.  In a typical digital 
photo, the primary colors of red, green and blue 
(from the RGB color model) create all the colors in 
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Glossary
preset can be seen in the preset preview window lo-
cated at the top left hand side of the interface above 
the preset list. 

Preview- Shows the processed preview of the image.

RAW image - An image file format that contains un- 
touched, “raw” pixel information straight from the 
digital camera’s sensor.  It has yet to translate the in-
formation in each pixel into the full color information, 
so this format offers more control over how the final 
JPEG or TIFF image is generated. 

Reduce Blur - An de-blur function that uses decon-
volution technology rather than simple sharpening 
techniques.

Refine – Improve (something) by making small changes to 
make it more subtle and accurate. 

RGB - Red, Green, Blue. The color model that is used in 
digital cameras and by computer monitors.

Saturation - The difference of intensity within a spe-
cific hue.

Shadow - A dark area or shape produced by a body 
com- ing between the rays of light and a surface.

Sharpness - The clarity of detail in a photo.

Smoothing - To make a surface more regular or con- 
sistent; free from perceptible projections, lumps, or 
indentations.

that detracts from overall image quality or something 
you can choose to create artistically.

Opacity – The amount of transparency a layer has.

Pan and Zoom - A useful function that allows users to 
magnify the captured image in the preview and then, 
by using the cursor, to move or pan around the image. 
Typically Pan and Zoom allows users to magnify the 
image 2x or 4x time.  By magnifying the images and 
zeroing in on a specific section, you can see details 
not visible when the entire image is sized to fit the 
preview.

Parameter - A numerical or other measurable factor 
forming one of a set that defines a system or sets the 
conditions of its operation.

Photo-editing or Imaging software – Programs in 
which you can alter your photos and / or create digital 
images.  Depending on the software, you can improve 
exposure, color and other attributes of your picture, 
paint on it, add type, apply special effects, remove 
noise, resize it, combine it with other pictures, pre-
pare it for e-mail or posting on the web, output it to a 
printer, or do any number of other manipulations or 
edits.

Plug-in - A computing feature with the ability to be 
added to a system to give extra features or functions.

Preset - A pre-defined combination of parameters and 
settings that is saved into a folder within Topaz Detail 
2. Topaz provides default presets.  A preview of each 



40

User Manual
To

pa
z 

 D
et

ai
l paz Detail 2. Afterwards, right-click any 

empty spot and paste the Topaz_Detail2.plugin file into 
the Photoshop Plug-Ins folder. 
3. Quit and restart Photoshop and Topaz Detail 2 will 
appear in your Filters menu. 

“Do you have any other Detail tutorials?”
Yes, please see pages 27 and 32 of this Topaz Detail 
user guide, and also visit: http://www.topazlabs.com/
tutorials/detail

“I do not have Photoshop, will  Detail work with my El-
ements, Aperture, Lightroom, iPhoto Paint Shop Pro, 
Photo Impact or Irfanview?”
Yes, you can use Topaz Detail with any of the above 
host programs.  However, to use Detail in Aperture, 
Lightroom or iPhoto, you will need to download the 
free Topaz Fusion Express plug-in. For more informa-
tion please visit: www.topazlabs.com/fusion

“What are the limitations of the trial version of your 
software?”
The only limit on the trial versions of the Topaz plug-ins 
is time.  The free trial versions are designed to enable 
you to experience the full functionality of our plug-ins 
for a 30-day trial period.  After the trial period is up, you 
will only be able to use the Topaz software by purchas-
ing it.  You will then receive a license key to activate the 
plug-in, and the trial version will automatically become 
the full version with no time limitations.          

“I need a Topaz Detail trial key.” 
Visit http://www.topazlabs.com/downloads for a trial 
key.  Please check your Spam folder because your 
Spam filter sometimes filters out the automated email. 

If you need more time to evaluate, please e-mail us at 
www.topazlabs.com/support for an extended trial key. 
 

 “I can’t find Topaz Detail in the Photoshop Filters 
menu.” 
If you’re using Windows: 
1. Go to C:\Program Files\Topaz Labs\Topaz Detail 2\
Plugins. Right click the file 
“tldetail2.8bf” and click “Copy”. 
2. Go to your Photoshop Plug-Ins folder, usually located 
at C:\Program Files\Adobe\Adobe 
Photoshop CSx\Plug-Ins. First, delete anything that is 
currently there that has to do with 
Topaz Detail 2 This includes any folder that might be 
labeled “TopazDetail 2” or any 
tldetail2.8bf file. After doing that, right-click on any 
empty space and click “Paste”. 
3. Quit and restart Photoshop and Topaz Detail will ap-
pear in your Filters menu. 

If you’re using Mac: 
1. Go to /Library/Application Support/Topaz Labs/De-
tail2/Plugins and right-click 
Topaz_Detail2.plugin. Click “Copy”. 
2. Go to Applications/Adobe Photoshop CSx/Plug-Ins 
(or wherever your Photoshop Plug-Ins 
folder is located). Delete any current reference to To-

Frequently Asked Questions
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Frequently Asked Questions
“If I use the 30-day trial version will I need to uninstall 
the trial version before I upgrade to a full version?”
No, the Topaz trial software is designed to be unlocked 
to become the full version simply by entering a license 
key.  The full license key will be e-mailed to you immedi-
ately after you purchase the software.

“Where do I enter my key?”
To enter your key please open an image in Photoshop 
and go to Filter -> Topaz Labs -> Detail 2 -> Menu -> 
Enter Key.  You can then copy & paste or type in your 
license key and then select OK.

“I had Topaz Detail as a trial, then I purchased. How do 
I enter my new license key?”
You can enter your new license key by opening up an 
image in Photoshop and go to Filter -> Topaz Labs -> 
Detail 2 -> Menu -> Enter Key.  Please remove the trial 
key and enter your new purchased license key, then 
select OK and you are all set. 

“My Topaz Detail  key doesn’t work!”
There are a couple of reasons why Topaz Detail might 
think your upgraded key is invalid.

First, make sure that your key is in the proper format. 
It’ll be in the format “xxxxxx-xxxxxx-xxxxxx-xxxxxx-
xxxxxx” and will be all numbers in 30 digits in five 
groups of six (no letters). 

Second, make sure that as you’re entering the key 

there is nothing in the space beforehand.  This means 
clicking, pressing Ctrl-A, and hitting delete to make sure 
that absolutely nothing is in that field before you paste 
in the key.  If it doesn’t work when you copy and paste, 
try typing it out, and vice versa.

My Topaz filters are grayed out in the filter menu. 
Please make sure that you are using a 8-bit or 16-bit 
image that is in RGB color mode.  Also, if your project 
includes adjustment layers please make sure that you 
are not on an adjustment layer.  You will need to select 
the image layer.  This will allow you to access your To-
paz programs. 

My Deblur tab sliders are grayed out!
Please make sure that your image preview is zoomed in 
to 50% or more and this will enable the Deblur sliders. 

My image color is not the same as it was in the Detail 
interface after I process it!
Please make sure that your “Proof Color” feature is 
turned OFF and this will fix the issue.

I have a question not listed here. 
Please visit our knowledge base online at: 
http://www.topazlabs.com/support/kb/

If you are not able to find the answer there then con-
tact our support specialists online at: www.topazlabs.
com/support or e-mail customer support at: help@
topazlabs.com

http://www.topazlabs.com/support/kb/
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Shortcut Keys
Topaz Detail uses some shortcut keys to speed up your workflow. Many of these 
keys are similar to those in Photoshop. The following keys work at all times.  

Mac  and PC Shortcuts are the same unless indicated otherwise. 

D					          	 Expands / Collapses Detail Tab
T						      Expands / Collapses Tone Tab
B						      Expands / Collapses DeBlur Tab
C 						      Expands / Collapses Color Tab
S					          	 Takes a Snapshot
CMD-Shift-P		   CTRL-Shift-P   	 Recalls previous Snapshot
CMD-Shift-N		   CTRL-Shift-N		 Recalls next Snapshot
CMD-1			   CTRL-1		  View Original Image
CMD-2			   CTRL-2		  View Adjusted Image
Left or Right Arrow Key		      	 Scrolls through presets
Return (enter) key			        	 Applies selected preset
[ key 					          	 Reduces selected slider value by 0.1
] key					          	 Increases selected slider value by 0.1
Home Key 				         	 Set the slider value to minimum
End Key			       	      	 Set the slider value to maximum
Double-click slider name		       	 Resets the slider to it’s default value

Spacebar		       Spacebar	      	 View Original Image	
CMD-ALT-R		    CTRL-ALT-R      	 Reset All	
Zoom to Fit		  CMD-0		   CTRL-0
Zoom to 100%	 CMD-ALT-0		  CTRL-ALT-0
+ or CMD - +		    + or CTRL - +     	 Zoom In	
- or CMD - - 		  - or CTRL - -          	 Zoom Out			              
CMD -Z 		    Ctrl - Z	      	 Undo				               
CMD - Shift - Z	   Ctrl - Shift - Z    	 Redo				              		

MAC Shortcut 	      PC Shortcut 	      Action
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Connect with Topaz

Follow us on Twitter for notifications of 
recent news and easily get in touch with us 

whenever you feel like it!

Find us on our Facebook page and network 
with other Topaz users!

Participate in the entirely user-led Topaz 
Flickr group for a helpful and highly active 
community for Topaz Photoshop plug-ins!

Subscribe to our YouTube channel to keep 
up with any newly released product video 

tutorials!

Check out our new Forum and our blog for 
tutorials, tips and updates from Topaz Labs!

http://www.topazlabs.com/forum
http://www.facebook.com/pages/Topaz-Labs/19955996369
http://www.flickr.com/groups/topaz
http://twitter.com/topazlabs
http://www.youtube.com/topazlabs
http://www.topazlabs.com/forum
http://www.topazlabs.com/blog
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Topaz Labs LLC, a privately owned company in Dallas, Texas, focuses on developing advanced video and image enhance-
ment technology. With today’s widespread use of digital still cameras, digital video cameras, and HDTV, the need for high-
quality digital images and videos has greatly increased. Topaz Labs’ mission is to bring practical state-of-the-art image and 
video enhancement technology to both professionals and consumers.

Contact Information
	

Topaz Labs LLC
5001 Spring Valley Road
Suite 400 East
Dallas, TX 75244

Technical Support
Visit: http://topazlabs.com/support/
Email: help@topazlabs.com

For more information
info@topazlabs.com

Copyright © 2009 Topaz Labs, LLC. All rights reserved. http://www.topazlabs.com
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Image Plug-ins    

Go to http://www.topazlabs.com/downloads to get your 30-day free trial!

Ultimate control over 
image exposure, detail, 
and color gives you the 
power to make your 
photos pop.

Specializes in creat-
ing crisp and stylized 
images. Also features 
extensive smoothing 
capabilities. 

Advanced noise reduc-
tion filters noise while 
maximizing and retain-
ing image detail simply 
and effortlessly.

Takes any of your 
regular photos and ef-
fortlessly turn them into 
beautiful works of art.

Specializes in overall 
image improvement. 
Features sharpening, re-
constructing, enlarging, 
high-quality noise 
removal and JPEG arti-
fact damage tools. 

Increase video quality with this suite 
of video enhancement filters utilizing 
super-resolution technology. 

Advanced JPEG artifact 
reduction filters elimi-
nate JPEG compression 
artifacts while preserv-
ing image detail like 
never before. 

Video Plug-ins 

3 levels of intricate and 
specific detail enhance-
ment for naturally 
enhanced images with 
no halos. 

Bring the power of 
Topaz to your Aperture, 
iPhoto and Lightoom 
workflow with the new 
Fusion Express plug-in.

Remove unwanted 
backgrounds from your 
digital images quickly 
and easily with the new 
Topaz ReMask. 

Easily and efficiently capture video 
frames and significantly increase their 
quality and resolution with this stand-
alone Windows application. 




